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Copyright © 2007 Cummins Inc. All rights reserved. No part of this 
documentation may be reproduced or transmitted in any form or by any 
means or used to make any derivative work (such as translation, 
transformation, or adaptation) without express written consent from 
Cummins Inc. 
 
Windows CE is a registered trademark of Microsoft.  
 
Cummins Inc. reserves the right to revise this documentation and to 
make changes in content from time to time without obligation on the part 
of Cummins Inc. to provide notification of such revision or changes. 
  
Cummins Inc. makes no representations or warranties that the 
documentation is free of errors.  The documentation is provided on an ‘as 
is’ basis.  
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DISCLAIMER 
POWERSPEC CE AND QUICKCHECK CE SOFTWARE, REFERRED 
TO HEREAFTER AS COVERED CODE, IS PROVIDED UNDER 
THIS LICENSE ON AN ''AS IS'' BASIS, WITHOUT WARRANTY OF 
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, WARRANTIES THAT THE COVERED 
CODE IS FREE OF DEFECTS, MERCHANTABLE, FIT FOR A 
PARTICULAR PURPOSE OR NON-INFRINGING.  LICENSEE 
BEARS THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE COVERED CODE.  SHOULD ANY 
COVERED CODE PROVE INEFFECTIVE IN ANY RESPECT, 
LICENSEE SHALL ASSUME THE COST OF ANY NECESSARY 
SERVICING, REPAIR OR CORRECTION.   THIS DISCLAIMER OF 
WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS 
LICENSE.  NO USE OF ANY COVERED CODE IS AUTHORIZED 
HEREUNDER EXCEPT UNDER THIS DISCLAIMER.  LICENSEE 
AGREES NOT TO TRANSLATE, REVERSE ASSEMBLE, REVERSE 
COMPILE, ADAPT, TRANSLATE, ALTAR, MODIFY, OR CHANGE 
IN ANY WAY THE LICENSED SOFTWARE OR ANY UPDATE 
THERETO WITHOUT THE PRIOR WRITTEN AUTHORIZATION 
OF CUMMINS.  LICENSEE AGREES THAT UNDER NO 
CIRCUMSTANCES SHALL LICENSOR BE RESPONSIBLE FOR 
ANY DAMAGES, WHETHER DIRECT, INCIDENTAL, 
CONSEQUENTIAL, EXEMPLARY OR PUNITIVE, STEMMING 
FROM LOSS OF USE, DATA, PROFITS OR OTHER LOSSES 
RESULTING IN WHOLE OR IN PART FROM LICENSEE’S 
INSTALLATION OR USE OF THE COVERED CODE.   BY ITS 
INSTALLATION OF THE COVERED CODE, LICENSEE AFFIRMS 
ITS ACCEPTANCE OF THE ABOVE DISCLAIMER AND 
RELEASES LICENSOR, ITS SUBSIDIARIES AND ITS AFFILIATES 
FROM ANY AND ALL CLAIMS FOR DAMAGE STEMMING 
EITHER FROM LICENSEE’S INSTALLATION OR USE OF THE 
COVERED CODE. 
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 Caution  
• Do not attempt to service the QC5100 Handheld yourself.  Do not 

disassemble, modify, drop, puncture, mutilate, solder, or alter the 
device. Always follow the installation instructions closely.   

• Do not expose the device to temperatures in excess of 60º C (140º 
F).  When heated to excessive temperatures, battery cell could 
explode or vent, posing a risk of fire. While a recharging battery 
will normally feel warm to the touch, a damaged pack may 
produce extreme heat or give off a burning odor.  Use only the 
specified charger to charge the battery. 

• Before you clean your QC5100 Handheld, disconnect the device 
from the vehicle, electrical outlet power, or person computer.  
Clean your handheld device with a soft cloth dampened with 
water.  Do not use liquid or aerosol cleaners.  Do not use abrasive 
cleansers or materials on the screen - they may cause scratches.  
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Welcome  
  
We thank you for purchasing a Cummins QC5100 Handheld Computer 
for Automotive and Industrial vehicle and diesel engine applications.  It 
is our hope that this device will add value to your already valuable 
Cummins engine by giving you the ability to read engine and vehicle 
subsystem information quickly and conveniently.  It is not intended to 
replace the Cummins INSITE™ tool.  It has limited functionality 
compared to INSITE™, but offers the advantage of being more portable, 
affordable, and convenient for basic engine and vehicle subsystem data 
gathering. 

The QUICKCHECK CE application communicates with the engine ECM 
(electronic control module) component, as well as other vehicle 
subsystem components that broadcast on the SAE J1939 or J1587 
datalink(s). 

The POWERSPEC CE application communicates with an engine ECM on 
the SAE J1939 or J1587 datalink(s). The POWERSPEC CE application is 
designed to work with late-model Cummins automotive engines (ISB, 
ISC, ISL, ISM, and ISX). 

Additionally, QUICKREPORT office software may be purchase to present 
easy-to-read reports from the POWERSPEC CE trip data. 

To transfer data from the QC5100 Handheld Computer to a PC requires 
version 4.5 of the Microsoft ActiveSync® synchronization technology 
software (included on the installation CD).  If your software is an earlier 
version, update it to the latest version without cost at the Microsoft web 
site: 
http://www.microsoft.com/windowsmobile/downloads/activesync45.mspx 
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Introduction to QC5100 Handheld  

When you first power on the Cummins QC5100 Handheld Computer, the 
QC5100 User Interface screen will be launched. 

 
Figure 1 – QC5100 User Interface 

Starting a QC5100 Application 
You have several options that can be selected from the QC5100 User 
Interface: 

• To start the POWERSPEC CE application, simply tap the 
PowerSpec icon on the screen or use the numeric key “1” on the 
keypad.  

• To start the QUICKCHECK CE application, simply tap the 
QuickCheck icon on the screen or use the numeric key “2” on 
the keypad.  

• To close the QC5100 User Interface and enter into the Windows 
CE User Interface, tap the Close icon on the screen or use the 
numeric key “9” on the keypad.  
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Introduction to Windows CE 

The QC5100 Handheld Computer is powered by Microsoft® Windows® 
CE, an operating system designed for mobile devices.  Windows PC 
users will find a familiar look and feel to the user interface of Windows 
CE-based devices.   

 

 
Figure 2 – Windows CE User Interface 

 
The Windows CE environment provides users with the tools necessary to 
access files, run applications, and change settings.  Windows CE includes 
the following user interface features: 
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Command Bar 
Use the command bar (also referred to as the taskbar) at the bottom 
of the screen to perform tasks within applications.  The command bar 
includes menu names, functions, and the Input Panel icon, when 
needed.  To see the name of an icon, tap and hold the stylus on the 
icon. To cancel the action, drag the stylus off the icon. 

Popup Menus 
Tap and hold an item to see a pop-up menu containing a list of 
actions that can be performed. Pop-up menus allow quick and easy 
access to the most common actions. When the menu appears, tap the 
action to be performed.  To cancel the menu, tap anywhere on the 
screen outside the menu. 

Stylus and Taps 
The stylus replaces the mouse in the Windows CE environment and is 
used as follows: 

Tap  Touch the screen once with the stylus to select 
options, close applications, or launch menus from 
the taskbar. 

Double 
Tap  

Touch the screen twice with the stylus to launch 
applications. 

Drag  Hold the stylus on the screen and drag across the 
screen to select text and images. 

Tap and 
hold  

Tap and hold the stylus on an icon to see a list of 
actions available for the item. On the pop-up menu 
that appears, tap the action to be performed. 
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Control Panel 

The Windows CE Control Panel can be used to configure and 
customize the settings of the QC5100 Handheld Computer.   Use the 
Control Panel for such tasks as changing the speaker volume, 
adjusting the display, or monitoring the battery level.  

 
Figure 3 – Control Panel 

To launch the Control Panel, tap the Start button in the Command 
Bar.  Next tap Settings.  Then tap Control Panel.  
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About Your QC5100 Handheld 

This section will introduce some of the basic components of the QC5100 
Handheld Computer, including its display, memory, and keypad.  

 
Figure 4 – Front View 
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Touch Screen 

 
Figure 5 - Touch Screen Calibration 

Use the touch screen to enter information into the device.  If the 
device is not responding properly to presses on the touch screen, a 
recalibration may be required.  Press and hold the Shift and Power 
keys for approximately four seconds to launch the Touch Screen 
Calibration screen.     

Stylus 
Use the stylus to draw or tap on the touch screen. To remove the 
stylus, pull it straight up and out of the holder. Make sure to return 
the stylus to its holder when not in use. 

LED’s 
The orange LED indicates the status of the battery-charging 
circuitry.  The green LED indicates the status of the datalink. 
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Display 
The QC5100 Handheld Computer contains a 3.8” LCD display with 
a resolution of 240 x 320 pixels.   The device is a monochrome LCD.   
The backlight of the LCD can be shut off to preserve power.  Press 
and hold the Power key for approximately one second to toggle the 
backlight on and off. 

 

 
Figure 6 – Display Properties 

Contrast 

If the monochrome LCD isn’t viewable, its contrast may need to be 
adjusted.  Press and hold the Shift and Power keys to launch the 
Contrast Control Panel.  The unit will beep to acknowledge that the 
Control Panel is running.  The Left and Right Arrow keys can then 
be used to adjust the contrast. 
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Speaker 

 
Figure 7 – Volume & Sounds Properties 

The QC5100 Handheld Computer includes a front-facing speaker 
with a sound pressure level of 70 dB.  Use the Volume & Sounds 
Control Panel to configure the speaker settings.  Move the slider to 
select the desired volume level.   The sounds associated with 
different system events can also be adjusted. 

Memory 
RAM 

The QC5100 Handheld Computer contains 64 MB of RAM 
(Random Access Memory).   Approximately half of this memory 
is used by the Operating System.   The remaining part of the 
memory is used to run applications.  To launch an application, 
tap Start, then tap Start > Programs, and then select the 
application.  When a new application is launched, the previous 
application does not need to be closed.  Windows CE will 
manage this memory automatically. 
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  Flash Memory 
The QC5100 Handheld Computer contains 32 MB of Flash 
memory.   Part of Flash memory contains the Windows CE 
Operating System and device-specific files installed at the 
factory.  These files cannot be deleted or accidentally lost from 
the system. 

 

 
Figure 8 – OnBoard Flash 

 
The remaining part of Flash memory is allocated to the Onboard 
Flash Drive, an internal drive that can be used to store critical 
nonvolatile files.   To access the drive, double-tap My Device, 
and then double-tap OnBoard Flash. 
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Keypad 
 

 
Figure 9 – Keypad Layout 

Keypad Layout 
The QC5100 Handheld Computer features a keypad consisting 
of twenty keys, as shown in Figure 9 – Keypad Layout.   The 
keypad includes the following: 

• Arrow Keys 
• Numeric Keys 
• Tab 
• Enter 
• Backspace 
• Shift 
• Power 
• Reset button 

Power Key  
The Power key is used to turn the unit on and off.  When the 
Power key is pressed to turn the unit off, the QC5100 Handheld 
Computer actually enters Suspend mode.  In Suspend mode, the 
unit continues to supply power to all memory, but turns off 
power to most hardware.  This feature is designed to prolong 
battery life.  When the Power key is pressed to turn the unit back 
on, the unit exits Suspend mode. 
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The Power key can be used to generate shortcuts to various 
QC5100 Handheld Computer functions.  These shortcuts are as 
follows: 

Toggle Backlight.  Press and hold the Power key for 
approximately one second to toggle the backlight on and off. 

Calibrate Touch Screen.   Press and hold the Shift and Power 
keys for approximately four seconds to launch the Touch Screen 
Calibration screen. 

Adjust Contrast.  Press the Shift and Power keys briefly to 
launch the Contrast Control Panel. 

Reset Button 
A reset may become necessary when the device no longer responds 
to a tap or button press.  For example, the device may require a reset 
after the battery power drops below a critical level. 
The three types of resets include: 

• Soft Reset  
• Hard Reset 
• Full Reset  

Soft Reset  
This is comparable to restarting a Windows PC.  It reboots the 
operating system and preserves any saved data.  Press and 
release the Reset button to perform a Soft Reset. 
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Hard Reset  
In cases where the internal RAM is corrupted to the point that 
the unit will not boot, it may be necessary to perform a Hard 
Reset.  Hold down the Power key while pressing and releasing 
the Reset button to force a Hard Reset.  The following dialog 
should appear on the screen: 

 

Figure 10 – Erase All Data 
Press the Up Arrow key to continue with the Hard Reset.  If any 
other key is pressed, the unit will perform a Soft Reset.   Note: 
Files stored in the OnBoard Flash folder are NOT erased by a 
Hard Reset. 

Full Reset  
To restore a unit to its factory defaults, a Full Reset is required.  
A Full Reset will erase all of RAM as well as the Windows CE 
Registry.  The Registry is a database stored in Flash memory that 
contains system information, including: 

1. Touch Screen calibration data 
2. Contrast settings (monochrome units only) 
3. Brightness settings 

To force a Full Reset, press and hold the Shift and Power keys 
while pressing and releasing the Reset button. 
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USB Connector  

 
Figure 11 – USB Cable 

The QC5100 Handheld Computer includes a proprietary cable for 
connecting it to a standard USB port on a Windows PC.   The USB 
cable is used for charging the internal battery, as well as for 
establishing an ActiveSync connection between the QC5100 
Handheld Computer and a PC. 
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Battery Charging  
The QC5100 Handheld Computer contains a non-removable Lithium 
Ion soft-pack cell with built-in 
protection circuitry.  It has a battery 
life of approximately 10 hours 
(depending on usage). Launch the 
Power Properties Control Panel to 
change the settings which affect 
battery life.  When connected to a PC 
via the USB cable, the battery will 
recharge in eight hours.   If DC power 
is used, the battery will recharge in 
four hours.  The orange LED on the 
front of the unit will indicate when 
the unit is charging. 

     
Figure 12 – Power Properties 

ActiveSync 
ActiveSync is a feature of Windows CE Services that manages data 
synchronization between the QC5100 Handheld Computer and a 
Windows PC.   Use ActiveSync to back up and restore device data or 
copy files between the device and the PC. 

PC Requirements 
Windows XP Media Center Edition; Windows XP Professional 64-
Bit Edition (Itanium); Windows XP Service Pack 1; Windows XP 
Service Pack 2; Windows XP Tablet PC Edition.  
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Installing QC5100 PC Software 

To install your QC5100 PC Software, please follow the instructions below: 

1. Insert the QC5100 Application Suite CD into your CD ROM drive. 

2. Find and run the installation file called:  
QC5100 Application Suite Install.exe 

3. Follow the instructions on the screen 

4. When the installation program is ready, please start the application 
called SyncReports by clicking: 
Start All Programs Cummins QC5100 Application 
Suite Launch SyncReports 

5. This will launch the installation program for Microsoft Active Sync, 
unless it was already installed, please follow the instructions on the 
screen. When the installation is complete, please connect your QC5100 
device to your PC using the USB connector. 

6. The PC will now automatically recognize the device as a USB serial 
device but it still needs to install some drivers. Please follow the 
instructions on the screen and choose to automatically find and install 
drivers for the device.   

7. After the drivers are installed, you are ready to synchronize the QC5100 
device with the PC. Do this by simply disconnecting and then 
reconnecting the USB cable between the QC5100 device and the PC.  
This will automatically start the SyncReport application, which will 
handle the synchronization and possible updates of the QC5100 
software.    
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Installing the USB Driver for ActiveSync 
The appropriate USB driver from the companion CD must be 
installed on the PC.   If the driver isn’t installed, ActiveSync will not 
be able to communicate with the QC5100 Handheld Computer.  
Make sure the QC5100 unit is running.  Connect the QC5100 
Handheld and the PC with a USB cable.  The PC should then launch 
the Found New Hardware Wizard dialog.  

 
Figure 13 - Found New Hardware Wizard 

Select the Install from a list or specific location (Advanced) option.  
Then click Next. 
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Figure 14 - Select the Driver Dialog 

The Found New Hardware Wizard should detect the device as USB 
Sync. Click Have Disk.  Browse to the file wceusbsh.inf from the 
CD.  Then click Next.  

 

 
Figure 15 – Hardware Installation Warning 

When the Hardware Installation warning launches, click Continue 
Anyway.   After the New Hardware Wizard has completed, the driver 
should be successful installed. 
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Transferring Files via ActiveSync 

 
Figure 16 – Mobile Device 

The ActiveSync icon in the PC’s system tray will turn green when a 
USB connection is established.   Right-click the icon and then select 
Explore.  This will launch the Mobile Device window on the PC.  
Files can now be transferred to and from the device. 
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Introduction to PowerSpec CE 
The POWERSPEC CE application allows you to read and capture select 
engine and subsystem data from your diesel-powered vehicle. This data 
includes equipment identification information, equipment configuration, 
fault information, current operating parameters, and trip parameters. 
With POWERSPEC CE, you can: 

• Read and store engine configuration information 
• Read both active and inactive engine faults.  
• Clear inactive faults from the ECM. 
• Read Feature Settings from the engine. 
• Read Engine Data Plate.  
• Edit Customer Name, Customer Location and Vehicle Unit 

Number 
• Read and reset trip data, such as idle parameters and vehicle 

distance. 
• Edit Feature Settings using the Transfer HotSpec option. 

Activating POWERSPEC CE 
Once installation is complete, the POWERSPEC CE 
application icon depicted at the right appears on the 
application launcher.  Tap the icon to launch the 
POWERSPEC CE application. 

Main Menu Screen 
Once the POWERSPEC CE icon is tapped, the Main Menu screen 
appears.  This screen displays the Trip Information, Fault Codes, 
Read Feature Settings, Dataplate and Transfer HotSpec screens. Each 
option, as described later, is considered to be a data display screen. 
This allows certain information and functionality to be available in 
multiple places in the application. 

The Main Menu screen contains several screen objects—each 
pointed out in the picture below and described in the paragraphs that 
follow.  
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Current Screen 
This label is an indicator of which screen is currently being 
displayed: Trip Information, Fault Codes, Read Feature Settings, 
Dataplate or Transfer HotSpec.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Navigation  
A single screen tap allows the user to easily select the desired 
screen.  This enables one to navigate to any other screen in a 
convenient, intuitive fashion.  Using the Up and Down arrow 
keys will also navigate the main menu options. 

Hot Keys 
Hot keys allow the user to easily select the desired screen with a 
key function.  This enables one to navigate to any other screen in 
a convenient, intuitive fashion.  Selecting the numeric key value 
will also change the viewing screens. 

Hot 
Keys 

     Menu 
      Bar 

 
  

 

Exit Icon

Current 
Screen 
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Exit Icon 
This icon is used to exit the 
POWERSPEC CE application. 
Tapping this icon will display the 
“Are you sure…” box shown in the 
figure to the right.  Clicking ‘Yes’ 
will exit the application.  Clicking 
‘No’ will return the user to 
POWERSPEC CE. 
 
 
 
 

Trip Screen 
The Trip screen is utilized to monitor 
vehicle trip-related data, such as 
vehicle distance, fuel consumed, and 
speed settings. It also displays lifetime 
totals of the engine and ECM. This is 
useful for understanding the vehicle 
usage.  The units displayed can be 
converted to the metric system by 
using the CONFIGURATION OPTIONS. 
The trip data may be saved in a report 
format using the Reset Trip option. 
The trip data ‘must’ be reset in order 
for a trip report to be created.  

Reset Trip  
If the Engine contains a Reset 
or Master password, the 
password must be entered 
before the trip data can be reset. 
The Reset password can be pre-
entered under the Configuration 
Options. 
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If the Engine does not 
contain a Vehicle Unit 
Number, the Vehicle Unit 
Number must be entered 
before the trip data can be 
reset. Selecting OK on this 
screen will display the Edit 
Dataplate screen. 

 
 
 

Read/ Reset Faults 
The Fault screen's primary purpose is the display of diagnostic fault 
codes that are currently recorded on the vehicle.  The list box 
contains the Active and Inactive Faults (if any are recorded on the 
vehicle), respectively.  The Current Screen, Navigation Tabs, and 
Exit Icon are available on this screen. Using the Up and Down 
arrows will traverse through the fault lists. Pressing the Enter key on 
a selected fault will display the Fault Description dialog box 
(described below). 
 

Engine Info 

        Active  
        Fault List 

Reset Faults 
 

         Scroll 
         Bar 

  Current 
   Screen 

 
  Exit Icon 

Scroll 
Down Arrow 
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Fault Description Dialog Box 
 
The list box on the Fault Screen 
shows all of the active or inactive 
faults that are recorded on the 
current ECM or that are stored in 
the current record. Faults are listed 
as PID/SID/SPN (see Glossary) 
and FMI numbers, along with an 
abbreviated textual description of 
the problem.  More descriptive 
information can be obtained from 
these codes by selecting the row of 
the desired fault with the stylus or 
pressing the Enter key while the 
selected row is highlighted. When 
a fault code is selected, the Fault 
Description dialog box is opened.  
The Fault Description dialog box 
provides more detailed information about the fault code. This includes a 
description of the fault, the Parameter Identifier (PID), Subsystem 
Identifier (SID), or Suspect Parameter Number (SPN), the Failure Mode 
Identifier (FMI), and the fault occurrence count. This information can be 
retrieved on current faults, as well as on fault records that are stored on 
the handheld device. When finished with the Fault Description 
information, exit this mode by tapping the ‘Done’ button on the form. 

Active-Inactive Faults 
A fault can be either active, which indicates that the conditions which 
trigger that fault are currently active, or it can be inactive, which 
indicates that conditions have existed in the past to trigger that fault 
code, but they no longer exist.  Both active and inactive types of faults 
can be monitored with the POWERSPEC CE application.  They are 
displayed in the Active or Inactive Faults lists, respectively. 
 
Reset Faults Button 
The Reset Faults button will issue a command to the ECM to remove the 
current inactive faults from the module.  This will also clear the fault lists 
and request all of the fault information again.  
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Read Feature Settings 
Select 'Read Feature Settings' to 
have POWERSPEC CE read your 
engine feature settings and display 
them in a viewable report. Then 
select 'Done' to close the report. 
Each time you read feature settings, 
POWERSPEC CE generates a report 
that can be viewed later using the 
Browse Engine Reports option 
from the top menu bar 'File' option. 
 
 
 

Data Plate 
Select 'DataPlate' to have 
POWERSPEC CE read your engine 
dataplate information and display a 
report. Then select 'Done' to close 
the report. Unlike the other four 
options above, POWERSPEC CE 
does not generate a report for this 
operation. 
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Edit Data Plate 
Select 'Edit…' to have POWERSPEC CE modify your engine data 
plate information. The Customer Name, Customer Location and 
Vehicle Unit Number can be modified and written to the engine data 
plate. Then select 'Ok' for POWERSPEC CE to write the changes to 
the data plate engine. Unlike the other four options above, 
POWERSPEC CE does not generate a report for this operation 

 
 
 
 
 
 
 
 
 

 

 

Transfer HotSpec Option 
The Transfer HotSpec 
option is used in 
conjunction with 
POWERSPEC PC to 
transfer a HotSpec to the 
QC5100 Handheld 
Computer. Each 
HotSpec contains a set 
of customized electronic 
engine feature settings to 
be transferred to a single 
engine type - ISX, ISM, 
ISL, ISC, or ISB.  

Create a HotSpec in PowerSpec PC 
The HotSpec created in PowerSpec PC can be moved to The 
QC5100 handheld device automatically by ‘Selecting the Save as 

 

  Input  
  Keyboard 
 

Modifiable  
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Spec that can be used on a QuickCheck handheld device’, then 
clicking the ‘OK’button.  

Moving the HotSpec  
The HotSpec will be automatically copied from the desktop PC 
to the QC5100 handheld device. The HotSpec can then be 
transferred to a matching Cummins engine via POWERSPEC CE. 

Transfer HotSpec 
Tap the ‘Transfer 
HotSpec’ option or press 
the ‘5’ key on the QC5100 
Handheld Computer.  The 
files are transferred to the 

Handheld and the list is 
automatically update. If a 
newly transferred HotSpec 
does not appear in the 
Tranfer HotSpec window 
exit the PowerSpec 
appl;ication and return to 
the Transfer HotSpec 
option. This allows the 
feature database to be 
updated. 
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Double tap the name of the 
feature spec to be 
transferred and select 
Transfer Spec to complete 
the transfer. You must 
already be connected to the 
engine before you select 
the HotSpec. If the ECM is 
password protected, and 
that password is not 
already entered into the 
HotSpec, POWERSPEC CE 
will prompt you to enter 
the Master Password or 
Adjustment Password. If 
the password is not entered 
correctly within three tries, 
the transfer will abort.   Once the transfer completes, you will be 
prompted to turn the engine key off and back on again. Tap 'OK' 
after keying off the engine, and POWERSPEC CE will show you 
the Feature Change Report in the default 'Changes Only' mode, 
which means that it only shows feature settings that were 
changed during the transfer. If no parameters were changed, the 
'No Changes Found’ message will appear. Each time you transfer 
a feature spec to the engine a change report is generated and 
saved to your handheld. You can view these reports later by 
using the "File Browse Engine Reports" option from the top 
menu.  

Install and License PowerSpec PC 
POWERSPEC PC may be obtained from our website at 
www.powerspec.cummins.com. Once the POWERSPEC PC software 
has been installed and the desktop PC has been licensed, a HotSpec 
may then be created. 

Note: Licensing the Desktop PC requires an Internet connection, for 
traceability purposes. PowerSpec will remember your licensed PCs, 
so you will only have to license them once. 
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Register the QC5100 Handheld Computer 
In the Select Target ID(s) PCs form, select the Register New PC’s 
button; enter a PC description (meaningful to you) and the PC ID of 
each target (obtained from POWERSPEC CE’s 'About' menu option on 
each QC5100 Handheld Computer). 

Browse Engine Reports  
Browse Engine Reports is used to view data records that have been 
stored on the handheld unit.  For the POWERSPEC CE application, the 
only information that is stored is Trip Information, Fault, Feature 
Settings and Feature Settings Change Report.  In order to view 
previously saved Engine Reports, simply select File from the main 
menu and select Browse Engine Reports. Records that are saved on 
the handheld device remain there until they are deleted or until they 
are synchronized to the PC, at which point they are no longer 
available on the QC5100 Handheld Computer. 

Equipment Pull-Down 
The Equipment Pull-Down is used to classify records according 
to the vehicles they were extracted from.  The items on this list 
correspond to the unique Vehicle Unit Number that was entered 
for a particular vehicle.  The engine serial number is displayed 
next to the Vehicle Unit Number, for each of the vehicle engines 
in this list will be unique.   

    Scroll Bar 
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   Delete  
   Record 
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Icon 

Reports by 
date 

   Report 
Categories 
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Record List 

The Record List will show all records saved for that vehicle. 
Remember that, once ActiveSync’ed, these records are archived 
to the PC.  The desired vehicle is selected from the Equipment 
Pull-Down; select the desired record by report type, sorted by 
extraction date. 

Deleting Records 
Records can be deleted by utilizing the delete icon or tapping the 
word ‘Delete’ to the right of the record to be deleted.  This will 
erase the current record from memory.  Once erased, this record 
can be neither viewed nor transferred to the PC during an 
ActiveSync process.  Note that deleting records on your 
handheld does not affect files already stored on your PC. 

Configuration Options 
The Configuration Options screen allows the user to select the Unit 
of Measure, Pre-Enter Reset Password, and Datalink connections. To 
change the Unit of Measure, select English or Metric by tapping the 
desired radio button. Enter the Reset password by tapping the ‘abc’ 
button next to the password text box and typing the correct Reset 
password. Tap the ‘abc’ button again to close the input keyboard. 
Tap OK to save and exit the screen.  When you open the 
POWERSPEC CE application, it will start in Auto Detect mode and 
make a default connection to the J1939 datalink if it is available, or it 
will select the J1708 datalink if the J1939 datalink is not active. 
Select the appropriate datalink and press OK.  The application will 
be “forced” to use only the selected datalink throughout the duration 
of its execution. This only changes the datalink selection for this 
session. This selection will not be saved once the POWERSPEC CE 
application is closed.  
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About Screen 
The About screen displays information about the POWERSPEC CE 
software such as the current version and build date. It also contains 
the PC ID that must be used when creating a HotSpec. Activate the 
About screen via the Help menu item and selecting ‘About’. 
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Number 

PC ID 
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POWERSPEC CE Basic Tutorial 
This section describes a typical data-gathering session.  It begins with 
collecting (scanning) the data, saving data, reviewing previously 
collected data, then downloading the saved data to the PC using the 
ActiveSync process, and finally how to remove POWERSPEC CE stored 
data from the handheld.  This tutorial assumes the following: 

• The handheld device will be connected to a vehicle that it has not 
been previously connected to. 

• The user is familiar with handheld organizer standard operations. 
• The cables and handheld device have all been properly 

connected. 
 

Attach the 25-pin connector to the QC5100 Handheld Computer.   
Connect the appropriate 6-pin or 9-pin Deutsch connector to the 
vehicle’s service connector.  The engine should be keyed “ON”.  
Tap the POWERSPEC CE application icon. 
 
Verify the Main Menu screen is displayed. If POWERSPEC CE 
was entered from the application launcher, Main Menu is the 
default screen. 

 
 Tap the Trip Information screen or ‘1’ on the device keypad  
When a successful connection is established, POWERSPEC CE 
displays a window with updating messages such as ‘Connecting 
to vehicle,’ then ‘Reading Module Info,’ and finally ‘Reading 
Trip Info.’ Then the Vehicle trip info will display with the Reset 
Trip option at the bottom of the screen. Tap the Engine Info at 
the top of the screen to view data.  Select the Trip screen and 
vehicle trip information will be displayed (for example, 
Maximum Road Speed, Total Fuel Used, etc.). 

 
Tap the ‘Reset Trip’ button to reset trip data and create a trip 
report. The trip data must be reset and the trip distance must be 
greater than one mile to create a trip report.  
 
Next choose Fault Codes by tapping the Fault Code or pressing 
the ‘2’ on the keypad. This screen shows current engine faults 
and inactive faults. Select Reset Faults to remove any inactive 
faults from the engine. If faults are present, you will see them 
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listed in the Faults List box located on the Fault screen.  
Selecting any fault takes you immediately to a pop-up that 
displays more details about the selected fault. 
 
At this time, select the File Browse Engine Reports menu item. 
The application saves the current values for the equipment and 
fault information.  This information is time-stamped and can be 
viewed later, even when POWERSPEC CE is not connected to the 
engine. You can view previously stored data on the handheld by 
selecting the File Browse Engine Reports menu item.  When 
Browse Engine Reports is selected, a pull-down menu is 
available at the top of the screen. Once a piece of equipment is 
selected, four report categories are displayed. Each category will 
contain record entries for that particular vehicle. 
 
Previously stored data can be deleted while Browsing Engine 
Reports.  Choose the equipment from the pull-down list and 
select either the ‘Delete’ icon or tap Delete on the device screen.  
Deleting the record will only remove the currently viewed 
date/time record from the record pull-down list. 

 
Note:  It is recommended to perform an ActiveSync operation before 
deleting any equipment data from the POWERSPEC CE application. 

Step 6: 
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Installation 
The installation of the POWERSPEC CE is described in the QC5100 
Installation of PC software section. 

Data 
The conduit transfers five types of information from the handheld 
organizer to the PC— engine information, trip, faults, feature 
settings, and feature settings change reports.  It creates and maintains 
four “globally accessible” files, one for each type of data.  By default 
the files are placed in:  
C:\Documents and Settings\All Users\Application 
Data\Cummins\QC5100\Reports 
The four reports are placed in a directory under the engine serial 
number. The engine information is contained in the engInfo.xml 
under the engine serial number directory. 
 
An additional copy of the trip information is placed in: 
C:\Documents and Settings\All Users\Application 
Data\Cummins\Common\Reports  
To be used by the QuickReport reporting software. 

Upon a successful synchronization of POWERSPEC CE data, the 
conduit instructs the handheld device to remove the downloaded 
fault, trip, feature settings and feature settings change reports from 
the handheld organizer, freeing disk space for future downloads or 
other application data.  As a result, all fault, trip, and equipment data 
older than the last synchronization is not available to be examined on 
the handheld device—only on the PC. 

Formats 
The conduit writes in spreadsheet-compatible XML file format.  
Each entry or record is a single line with multiple fields.  This allows 
files to be easily imported into a program such as Microsoft Excel 
for further analysis.   
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Introduction to QUICKCHECK CE 
The QUICKCHECK CE application, in conjunction with the QC 
CONFIGURATOR program, allows you to read and capture select engine 
and subsystem data from your diesel-powered vehicle. This data includes 
equipment identification information, equipment configuration, fault 
information, current operating parameters, and trip parameters. 
With QUICKCHECK CE, you can: 

• Read and store engine configuration information 
• Read and store both active and inactive engine and subsystem 

faults 
• Monitor engine and subsystem operating parameters, such as 

engine rpm, coolant temperature, and transmission output shaft 
speed readings 

• Read engine trip data, such as idle parameters and vehicle 
distance 

• Clear Inactive faults from the ECM. 

Activating QUICKCHECK CE 
The QUICKCHECK CE application icon depicted at the 
right appears on the application launcher.  Tap the icon 
to launch the QUICKCHECK CE application. 

Equipment Screen  
Once the QUICKCHECK CE icon is tapped, the Equipment screen 
appears.  This screen, along with the Monitor and Trip screens 
described later, is considered to be a data display screen.  Each data 
display screen contains a connection status display, an exit icon and 
a menu.  This allows certain information and functionality to be 
available in multiple places in the application.  This section serves to 
document the repeated information for all screens.  A fourth screen, 
the Fault screen, is discussed later. The Equipment screen contains 
several screen objects—each pointed out in the picture below and 
described in the paragraphs that follow. 

 
 
 
 
 
  

Menu Bar 
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Current Screen 
This label is an indicator of the currently active screen: 
Equipment, Fault, Monitor, or Trip.  It changes as the Navigation 
Tabs are used to change between screens. 

Navigation Tabs 
Navigation Icons are available on all QUICKCHECK CE screens.  
These allow the user to easily select the desired screen with a 
single screen tap.  This enables one to navigate to any other 
screen in a convenient, intuitive fashion.  Using the Left and 
Right arrow keys will also change the viewing screens. 

Engine Information 
The Equipment screen displays information about the engine and 
its configuration.  If QUICKCHECK CE has been configured by 
QC CONFIGURATOR to read another vehicle subsystem’s faults, 
component identification information for this subsystem is 
displayed at the bottom of the screen.  Equipment information 
uniquely identifies a vehicle and can be used to distinguish one 
set of data from another.  With the exception of Total Engine 

    Connection 
    Status 

 
  Equipment 
  Identifier 

 Engine 
 Information 

Exit Icon 
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Hours (which is found underneath the Software ID on the 
equipment list), all data on this screen is static and should remain 
the same each time the vehicle is connected to QUICKCHECK CE.  
When more data parameters for a screen are available than can 
fit on the display, a scroll bar appears, which the user can utilize 
to move the display list up and down (alternatively, the Up and 
Down arrows on the handheld device can be used to scroll up 
and down the list). 

Equipment ID 
The Equipment ID is a unique 
item in that it is a label that is 
established by the user and will be 
associated with subsequent 
connections to that vehicle, as 
well as being used to identify that 
vehicle’s data.  Once the 
Equipment ID is established for a 
particular vehicle, it will 
automatically be retrieved on 
subsequent connections to that 
vehicle.  This feature allows the 
user to connect and save data from multiple vehicles. In order to 
establish an Equipment ID, the user must first connect to the 
desired vehicle.  If an Equipment ID has already been defined, it 
will appear in the Equipment ID field; otherwise that field will 
be blank.  In order to set or modify that field, simply tap the 
stylus on the field and an entry box will appear on the screen (as 
shown in the Figure on the right).  The user may then utilize the 
Input Panel keyboard to edit the field.  When finished, simply 
tap anywhere or use the exit button to close the Equipment ID 
box.  A save must be performed the first time an Equipment ID 
is entered for a new vehicle so that it can be retrieved in future 
connections. 
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Zoom Box 
Some data plate fields may 
contain strings of information that 
will not fit in the allocated display 
area.  For these fields, an 
expanded display zoom box allows 
you to view the entire field.  To 
activate the zoom box, simply tap 
the stylus on the field.  
Alternatively you may use the Up 
and Down arrows to highlight 
individual rows (as VIN is in the 
figure shown to the right) and then 
press the Enter key to activate the 
zoom box.  If it is supported for 
that row, the box will automatically appear.  Tap the Exit icon to 
close it. 

Parameter Value Validity 
Three of the four screens (Equipment, Monitor, and Trip) convey 
data validity information for a given value.  This easily lets you 
know whether a given value has been received or is up to date.  
In Live mode, if the screen is displaying normal information for 
a given parameter, it is the most recently received information.  
If the information becomes out of date, the values are displayed 
in rReverse Color o.  In addition, the fields can contain strings 
that convey the validity status of a given parameter.  For 
example, Disconnected or Unavailable is displayed if the data is 
not accessible. 

Connection Status 
This message field contains information about either the 
connection status or the data-saving status.  Messages such as 
J1939, J1587, No Adapter, Communicating, Datalink Down! and 
Saving are phrases displayed in this area of the screen.  When 
using QUICKCHECK CE, glance at this portion of the screen for 
an idea of the current overall status of the application. 
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Exit Icon 
This icon is used to exit the 
QUICKCHECK CE application.  
Tapping this icon will display 
the “Are you sure…” box shown 
in the figure to the right.  
Clicking ‘Yes’ will exit the 
application.  Clicking ‘No’ will 
return the user to QUICKCHECK 
CE. 
 
 
 

Fault Screen 
The Fault screen’s primary purpose is the display of diagnostic fault 
codes that are currently recorded on the vehicle.  There are two list 
boxes which contain the Active and Inactive Faults (if any are 
recorded on the vehicle), respectively.  The Current Screen, 
Navigation Tabs, Connection Status, and Exit Icon are available on 
this screen.  Using the Up and Down arrows will traverse through the 
fault lists.  Once you have reached the bottom of the Active Fault 
list, pressing down once more will expand the Inactive Fault List.  
Pressing the Enter key on a selected fault will display the Fault 
Description dialog box  
.  
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Faults Subsystem Selection 
Tapping the Fault Subsystem will expand 
to show all of the available subsystems 
from which faults may be read.  

 

 
 
 
 
 
 
 

Fault Description Dialog Box 
The list box on the Fault Screen shows all 
of the active or inactive faults that are 
recorded on the current ECM or that are 
stored in the current record if Review 
mode is activated.  Faults are listed as 
PID/SID/SPN (see Glossary) and FMI 
numbers, along with an abbreviated 
textual description of the problem.  More 
descriptive information can be obtained 
from these codes by selecting the row of 
the desired fault with the stylus or 
pressing the Enter key while the selected 
row is highlighted.  When a fault code is 
selected, the Fault Description dialog box 
is opened. The Fault Description dialog box provides more detailed 
information about the fault code.  This includes a description of the fault, 
the Parameter Identifier (PID), Subsystem Identifier (SID), or Suspect 
Parameter Number (SPN), the Failure Mode Identifier (FMI), and the 
fault occurrence count.   This information can be retrieved on current 
faults (in Live mode), as well as on fault records that are stored on the 
handheld device (in Review mode). When finished with the Fault 
Description information, exit this mode by tapping the OK button on the 
form. 
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Active-Inactive Faults 
A fault can be either active, which indicates that the conditions 
which trigger that fault are currently active, or it can be inactive, 
which indicates that conditions have existed in the past to trigger 
that fault code, but they no longer exist.  Both active and inactive  
types of faults can be monitored with the QUICKCHECK CE 
application.  They are displayed in the Active or Inactive Faults 
lists respectively. 

Clear Inactive Faults Button 
The clear inactive faults button will issue a generic command to 
the ECM to remove the current inactive faults from the module.  
This will also clear the fault lists and request all of the fault 
information again.  The Clear Inactive Faults button will be 
disabled unless the connected vehicle has inactive faults. 

Monitor Screen 
The Monitor screen is utilized to 
display live analog sensor and engine 
or subsystem parameter data, such as 
various speeds, temperatures, and 
pressures.  The units displayed can be 
converted to the metric system by 
using the QC CONFIGURATOR 
application. Depending on the engine 
or subsystem model,  some SAE 
parameters may not be supported on 
your vehicle.  These may show up as 
random character values or as 
‘Unavailable.’  You may contact the 
manufacturer of the engine or 
subsystem to verify whether that model supports a particular SAE 
parameter. The remainder of the controls and displays on the 
Monitor screen are identical to those on the Equipment screen.  Refer 
to the documentation on those controls for further information. 

Trip Screen 
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The Trip screen is utilized to monitor 
vehicle trip-related data, such as 
vehicle distance, fuel consumed, and 
speed settings.  This is useful for 
understanding the vehicle usage.  The 
units displayed can be converted to 
the metric system by using the QC 
CONFIGURATOR application. The 
remainder of the controls and displays 
on the trip screen are identical to 
those on the Equipment screen.  Refer 
to the documentation on those 
controls for further information. 

Switching Between Datalinks 
When you open the QUICKCHECK 
CE application, it will start in Auto 
Select mode and make a default 
connection to the J1939 datalink if it 
is available, or it will select the 
J1587 datalink if the J1939 datalink 
is not active.  You may manually 
select the desired datalink by using 
the Options Datalink Selector menu 
item.  The resulting dialog box will 
appear as shown in the figure to the 
right.  Select the appropriate datalink 
and press OK.  The application will 
be “forced” to use only the selected 
datalink throughout the duration of its execution. 

Review Mode 
Review mode is used to view data records that have been stored on 
the handheld unit.  For the QUICKCHECK CE application, the only 
information that is stored is equipment, fault, and trip information.  
In order to enter Review mode, simply use the Mode menu item and 
select Review.  The Connection Status display is replaced with a pair 
of record selection controls.  These controls are used to retrieve the 
desired record from storage on the handheld device.  Records that are 
saved on the handheld device remain there until they are deleted or 
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until they are ActiveSync’ed to a PC, at which point they are no 
longer available on the handheld device.  

Equipment Pull-Down 
The Equipment Pull-Down is used to classify records according to the 
vehicles they were extracted from.  The items on this list correspond to 
the unique Equipment ID that was entered for a particular vehicle.  That 
is, the serial number for each of the vehicle engines in this list will be 
unique.   

Record Pull-Down 
The Record Pull-Down will show all records saved for that vehicle.  
Remember that, once ActiveSync’ed, these records are archived to the 
PC.  Once the desired vehicle is selected from the Equipment Pull-Down, 
use the Record Pull-Down to load the desired record, identified by date 
and time.  The dataplate associated with that vehicle and the fault 
information associated with that record can then be reviewed.  Monitor 
parameters and the subsystem dataplate are not stored and are displayed 
as Unavailable.  This is due to the fact that the record is a single sample, 
which is typically not useful for analysis. 

       Equipment 
         Pull-Down 

  Record  
   Pull- 
  Down 
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Open File  
Configurator subsystem files can be 
accessed without leaving the QUICKCHECK   
CE application. Using the File menu item, 
and selecting Open File Records will 
display the Configurator .subsystem files.  

 

 
 
 
 
 

Deleting Records 
Records can be deleted by utilizing the File menu item and selecting 
‘Delete Record’ (which is only available in Review mode).  This will 
erase the current record from memory.  Once erased, this record can be 
neither viewed nor transferred to the PC during an ActiveSync process.  
Note that deleting records on your handheld does not affect files already 
stored on your PC. 

Deleting Equipment 
An equipment category and all its associated records can be deleted by 
utilizing the File menu item and selecting ‘Delete Equipment’ menu. 
This will erase the current equipment record from the equipment list and 
will delete all data records associated with that piece of equipment.  Once 
erased, these records can be neither viewed nor transferred to the PC 
during an ActiveSync process.  After the equipment record is deleted, 
QUICKCHECK CE will not automatically identify the vehicle with that 
information until a new equipment record is established. 

Launch Configurator 
QUICKCHECK CE allows the user to launch QC CONFIGURATOR from 
within QUICKCHECK CE.  This is achieved by using the ‘Launch 
Configurator’ menu item in the Options menu. 

Note: When QC CONFIGURATOR is closed, QUICKCHECK CE is 
automatically updated with the new set of parameters selected from 
QC CONFIGURATOR. 
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Units Selector 
The Units selector has two options: English or Metric.  Tapping this 
pull-down list allows changing the units that are displayed by 
QUICKCHECK  CE  for ALL parameters. 

About Screen 
The About screen displays information about the QUICKCHECK CE 
software such as the current version and build date.  It also contains 
information about the built-in INLINE 4 datalink adapter, such as the 
adapter firmware version and supported protocols.  Activate the 
About screen via the Options menu item and selecting ‘About’. 
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QUICKCHECK CE Basic Tutorial 
This section describes a typical data-gathering session.  It begins with 
collecting (scanning) the data, saving data, reviewing previously 
collected data, then downloading the saved data to the PC using the 
ActiveSync process, and finally how to remove QUICKCHECK CE stored 
data from the handheld.  This tutorial assumes the following: 

• The handheld device will be connected to a vehicle that it has not 
been previously connected to. 

• The user is familiar with handheld organizer standard operations. 
• The QUICKCHECK CE cables, adapter, and handheld device have 

all been properly connected. 

Attach the 25-pin connector on the to the QUICKCHECK 5100 
handheld device.  Connect the appropriate 6-pin or 9-pin 
Deutsch connector to the vehicle’s service connector.  The 
engine should be keyed “ON”3.  Tap the QUICKCHECK CE 
application icon.  By default the Connection Mode is in Live 
mode. The QUICKCHECK CE application immediately attempts 
to connect to the datalink. 

Next, verify that you are on the Equipment screen.  If 
QUICKCHECK CE was entered from the application launcher, 
Equipment is the default screen.  If the current screen is other 
than Equipment (i.e. Fault, Monitor or Trip), select the 
Equipment tab now. 

When a successful connection is established, QUICKCHECK CE 
displays the status “J1939” or “J1587.”  If the vehicle is 
communicating1 with QUICKCHECK CE, the fields on the 
Equipment screen are filled in as information is scanned, but the 
Equipment ID field is blank.  This field is populated by the user 
the first time a vehicle is scanned.  Touch to the right of the 
Equipment ID label to enter the desired text.  Using standard 
Input Panel text methods enter a name or label that is logical, 
user friendly, and easy to remember. 
You should still be looking at the Equipment screen where the 
engine Make, Model, and Serial No are listed, along with the 
VIN, Software ID, and Total Eng Hrs (engine hours).  If the 
QC CONFIGURATOR program was used to configure 

                                                             
1 The vehicle's key switch must be in the ON position. 
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QUICKCHECK CE to read subsystem faults or display the Rated 
Eng Pwr (engine power) parameter, not all fields will be visible 
on the screen at the same time, but they can be seen by scrolling 
down through the list.  If a field is displayed as Initial, 
Unavailable, or Disconnected after 30 seconds, QUICKCHECK 
CE is indicating that this particular piece of information has not 
been received on the datalink or the built-in INLINE 4 may not be 
connected correctly.  Check your connections to be sure that this 
is not the problem. 

Next choose Monitor by tapping the Monitor tab.  This screen 
shows current engine (or subsystem) operating information 
(sensor information such as engine speed, coolant temperature, 
and oil pressure) in real time, as they are broadcast.  Parameters 
that are not supported by a particular ECM version typically are 
displayed as ‘Unavailable’ all the time. 

Choose the Trip screen (tap the ‘Trip’ tab) and vehicle trip 
information will be displayed (for example, Maximum Road 
Speed, Total Fuel Used, etc.). 

If faults2 are present, you will see them listed in the Faults List 
box located on the Fault screen.  Selecting any fault takes you 
immediately to a pop-up that displays more details about the 
selected fault. 
You can switch between the Equipment, Fault, Monitor, and Trip 
screens at any time.   
Note: that the Equipment screen contains mostly non-changing 
information, while the other screens are continuously updated. 

At this time, select the File->Save Data Record menu item.  

 Doing this will initiate the data-saving mechanism of 
QUICKCHECK CE.  The application saves the current values for 
the equipment and fault information.  This information is time-
stamped and can be viewed later, even when QUICKCHECK CE is 
not connected to the engine. 

                                                             
2 The faults shown depend on the setting (Active or Inactive) of the fault pull-down. 
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You can view previously stored data on the handheld by 
selecting Mode->Review menu item.  When Review mode is 
selected, two pull-downs are available at the bottom of the 
screen: the one on the left chooses the equipment you want to 
see, and the one on the right lists records identified by dates and 
times of storage.   
Once a piece of equipment is selected, the other pull-down will 
contain record entries for that particular vehicle.  This allows 
you to select which stored record is currently viewable. 

Previously stored data can be deleted while in Review mode.  
Choose the equipment and record from the pull-down lists that 
you want to delete, then select the File menu item.  Select either 
the ‘Delete Equipment’ or ‘Delete Record’.  Deleting the 
equipment will remove the equipment from the equipment pull-
down list and all its records.  Deleting the record will only 
remove the currently viewed date/time record from the record 
pull-down list. 
Note:  It is recommended to perform an ActiveSync operation 
before deleting any equipment data from the QUICKCHECK CE 
application. 
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QC CONFIGURATOR 
The QC CONFIGURATOR is launched from the QUICKCHECK CE menu. 
The Display screen contains several screen objects, each pointed out in 
the picture below and described in the paragraphs that follow. 
 

 

Parameter List 
The parameter list table has a much larger set of parameters to choose 
from than the subset of base parameters that are available with the stand-
alone QUICKCHECK CE application.  The parameter list does NOT 
contain all of the available SAE parameters on the J1587 or J1939 
datalinks.  The parameter list has two columns.  The left column has 
checkboxes, which are used to select or deselect a parameter; located in 
the right column are the parameter names.  Changing a parameter's 
subsystem source address and viewing a detailed parameter description 
are possible by tapping the row of the desired parameter, as described 
later.  Note that a maximum of 35 QC Configurator parameters can be 
configured to be displayed on the QUICKCHECK CE Monitor screen. 

 Scroll Bar 

  Parameter List 

  Exit Icon 

 Subsystem Screens 

   Menu Bar 
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Faults Selector 
The Faults selector controls the faults displayed on the QUICKCHECK CE 
Fault Screen.  The Default list configuration is set to view the faults from 
Engine #1.  In order to view the faults from a different subsystem, such 
as a Transmission or Brakes, tap the Faults selector pull-down list to 
select that subsystem.  Note that component ID information (i.e., Make, 
Model, and Serial No.) will also appear at the bottom of the 
QUICKCHECK CE Equipment screen when selecting a subsystem other 
than Engine #1 to read faults (Engine #1 component ID information 
always appears near the top of the QUICKCHECK CE Equipment screen).   

Subsystem Screens 
The subsystem screens can be navigated through by use of the four tabs 
located near the top of the screen, labeled: Engine, Trans., Brakes, and 
Vehicle.  Each tab has associated with it a number of parameters that 
pertain to that label.  For example, parameters associated with a 
transmission will be found on the Trans. screen. 
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Menu Options 
The drop-down menu contains several options, each pointed out in the 
pictures below and described in the paragraphs that follow. 
 

 
New List 

Disregards any changes made and reloads the Default list 
into the Parameter list table. 

Open List 
Opens a pop-up list box with all stored configurations.  
Once a file name has been selected, the configuration is 
loaded into the Parameter list table. 

Save List 
If a modified Default list is currently open, then selecting 
Save List will prompt a pop-up box to be displayed  ‘Save 
As’ a new file name.  If the new configuration had already 
been saved under a user-defined name, then the old 
configuration is overwritten with the new changes for that 
file.  QC Configurator has the ability to save 15 different 
configurations. 

Configuration 
List Management 
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Save List As 
This menu item saves the current configuration with a 
different file name. 

Delete 
This menu item removes a configuration from the handheld 
device. 

Exit 
This menu item performs the same operation as the Quit 
button: exits the program without saving any changes. 

Help Screens 
The About screen displays the QC CONFIGURATOR current software 
version. Activate the About screen via the Help menu item and 
selecting ‘About’. 
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Parameter Identifier Description Screen 
In order to view the Parameter Identifier (PID) Description screen, tap 
the row of the desired parameter.  The Description screen contains 
several screen objects, each pointed out in the picture below and 
described in the paragraphs that follow. 
 

 
 
 

J1587 Parameter Number 
This is the SAE J1587 defined Parameter Identifier (PID) number.  
This number is for reference purposes only; it does NOT mean that 
this parameter is only available on J1587.  All QC CONFIGURATOR 
parameters are SAE-defined for both the J1587 and J1939 datalinks. 

 
SAE Standard Description 
This is based on the SAE-defined description of the parameter. 

 Subsystem  
 List 

SAE  Standard 
Description 

J1587 
Parameter 
Number 
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Subsystem List 
This pop-up contains subsystems with parameters that may be 
broadcast3.  In order to change the subsystem source of a parameter, 
tap the Subsystem pop-up list, select the desired subsystem, and save 
any changes you have made to update the QuickCheck CE databases 
with the new configuration.  The application will read from the 
selected subsystems for each parameter configured on either 
datalink.  Note that the combination of the faults subsystem and 
parameter subsystems you can configure with the QC Configurator 
program is limited to a maximum of 3.  If you select more 
subsystems than that for a configuration, you must remove one or 
more subsystems from your configuration; otherwise, QuickCheck 
CE will not properly read some of the messages you have just tried 
to configure it to read. 

                                                             
3 A parameter may not be broadcast from every subsystem listed.  Even the 
more common engine or vehicle subsystem parameters may be supported on 
some subsystem makes and models, but not on others. 
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QC CONFIGURATOR Basic Tutorial 
This section describes a typical configuration session.  It begins 
with creating a configuration, setting the units, and finally, 
saving the configuration. 
 
 
First, launch the QC CONFIGURATOR application from 
QUICKCHECK CE from the .  QC CONFIGURATOR will open to 
the default configuration list, which is the standard set of 
parameters for the QUICKCHECK CE application.  To create a 
custom configuration, begin by tapping the checkboxes of the 
desired parameters.  If you would like to re-configure a 
previously saved list, first open the list by using the Open menu 
command and make your changes to the parameters checked off 
on the list, their subsystem source, and the subsystem source for 
the Faults selector. 
 
To save the changes to a new configuration, you have three 
choices: 1) use the Save As menu option and create a new file 
name; 2) if you had opened a prior user-defined list, you can use 
the Save menu option and QC CONFIGURATOR will overwrite 
the old configuration. 
 
After the "Saving…Please Wait" message is gone, you can quit 
the program, either by tapping  Exit  option, using the Quit menu 
option, or tapping the Application key in the lower left area of 
your QC5100 handheld display to exit the program.  When you 
subsequently bring up the QUICKCHECK CE application, it will 
be configured with the changes you just saved using the QC 
CONFIGURATOR. 

Step 1:    
Selecting  

Parameters 
and Faults 

Step 2:   
  Saving 

        Lists 
 

 
Step 3:    

  Exiting    
Program 
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SyncReports 
Cummins SyncReports is the PC application that is handling 
synchronization bewteen the PC and the QC5100 handheld device. It is 
automatically started, (by Microsoft ActiveSync) once the device is 
connected to the PC using the USB cable. 
Cummins SyncReport handles the following: 

- Checks the device operating system version and makes an 
update if nedded.  

- Check the version of the POWERSPEC CE and 
QUICKCHECK CE and updates (or downgrades) to the 
same version the PC has installed. 

- Moved all reports from the device stores them under the PC 
folders: 
Example: 

o QUICKCHECK CE reports are copied to: 
C:\Documents and Settings\All Users\Application 
Data\Cummins\Common\QuickCheck 

o POWERSPEC CE reports are copied to:  
C:\Documents and Settings\All Users\Application 
Data\Cummins\PowerSpec\reports   

o All POWERSPEC CE trip reports are also copied to 
the input folder of QuickReport, typically located at: 
C:\Documents and Settings\All Users\Application 
Data\Cummins\Common\Reports 

  
- Adjust the date and time of the device to be same as the PC 
- Moves all HotSpecs from PC the matches the device PCID 

to the device. 
 
After Cummins SyncReports is ready a progress dialog is showing the 
result: 
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Tips: 

- Click Show More Details to view a detailed report of the 
synchronization process. 

- Click File -> Save Synchronization Result to save the details 
of the syncronization as a file. 

- Click Show Reports to get shortcuts to the location of 
QuickCheck. PowerSpec and QuickReport report files. 

- Click Help -> About to open the About Box 
 

Transfer Mechanism 
When the QC5100 Handheld Computer is connected to the PC 
(using the USB cable), SyncReports is executed and data is 
transferred from the handheld device to the PC. 

Data 
QUICKCHECK CE stores information in the form of an XML file 
(format given later).  Each XML file is named after the Serial 
Number of the Engine (ex., 034535986.xml).  If the file already 
exists on the PC, then the new information is appended to the 
existing XML file.  A new time stamp tag is created in the XML file 
and information (Trip and Faults) is added under this tag. 

Upon a successful synchronization of QUICKCHECK CE data, 
SyncReports instructs the handheld organizer to remove the 
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downloaded fault and trip records from the handheld device, freeing 
memory for future downloads or other application data.  As a result, 
all fault and trip data older than the last synchronization is not 
available to be examined on the handheld device – only on the PC. 

Location 
The location of the SyncReports output files is as follows: 
C:\Documents and Settings\All Users\Application 
Data\Cummins\Common\QuickCheck 

Formats 
The SyncReports conduit outputs files in XML format. All 
information is saved in a tagged format. The root tag contains the 
Engine information, which is common to all other data contained 
within that file. Fault and Trip information is saved under a Time 
Stamp tag. The format is shown below: 

 
<?xml version="1.0" encoding="ISO-8859-1" ?> 
<ROOT> 
     <VEHUNITNUM>Blue Truck</VEHUNITNUM> 
     <SERIALNUMBER>99887766</SERIALNUMBER> 
     <TOTALENGHRS>500.0</TOTALENGHRS> 
     <COMPONENTID>CMMNS*ISX 400*99887766*isxph9*</COMPONENTID> 
     <VIN>1234567890123456</VIN> 
     <SOFTWAREID>09030013</SOFTWAREID> 
     <TOOLID>QuickCheck CE 1.0</TOOLID> 
     <DATE TimeStamp="Jan 20, 2004 11:23:00"> 
<TRIP> 
<TOTALIDLEHRS>100.00</TOTALIDLEHRS> 
<TOTALIDLEFUELUSED>50.0</TOTALIDLEFUELUSED> 
<TOTALVEHDIST>12000.00</TOTALVEHDIST> 
<TOTALPTOHRS>0.0</TOTALPTOHRS> 
<TOTALFUELUSED>650.0</TOTALFUELUSED> 
<MAXROADSPEEDLIMIT>65.0</MAXROADSPEEDLIMIT> 
<CRUISECONTROLSETSPEED>63.0</CRUISECONTROLSETSPEE> 
 </TRIP> 

        <FAULT> 
<FAULTID>108</FAULTID> 
<FMI>4</FMI> 
<MID>0</MID> 
<FAULTCOUNT>2</FAULTCOUNT> 

  Faults 

Trip  
Information 

   Engine  
  Information  
 

Date – Time Stamp 
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<FLAGS>11</FLAGS> 
<FAULTDESC>Barometric Pressure - Voltage below normal or shorted low</FAULTDESC> 
</FAULT> 
<FAULT> 
<FAULTID>94</FAULTID> 
<FMI>4</FMI> 
<MID>0</MID> 
<FAULTCOUNT>2</FAULTCOUNT> 
<FLAGS>11</FLAGS> 
<FAULTDESC>Fuel Delivery Pressure - Voltage below normal or shorted low</FAULTDESC> 
</FAULT> 
<Date TimeStamp="Mar 14, 2004 10:47:00"> 
</Date> 
</ROOT> 
 
Engine Information 

Tag Name 
Description 

VEHUNITNUM String – user supplied identification 

SERIALNUMBER String – engine serial number 

TOTALENGHRS String – total accumulated hours of engine operation 

COMPONENTID String (variable length) – Make*Model*SerialNumber 

Note:  Make is always five characters; the Model and 
SerialNumber are variable length. 

The asterisks (*) are part of the string. 

VIN String – vehicle identification number 

SOFTWAREID String (variable length) – 
SoftwareID*AdditionalSoftwareIDField 

The asterisk (*) is part of the string. 

TOOLID String – Name and version number of the data extraction 
tool 

 
Faults Information 

Tag Name 
Description 

FAULTID Number – PID/SPN or SID, depending on flag value 
FMI Number – Failure Mode Identifier 
MID Number –  Machine identifier or source address 
FAULTCOUNT Number – number of occurrences of fault 
FLAGS 0x02 set if fault active (cleared if inactive) 

Faults 

  Second  
  Date- Time Stamp 



 

 67 

Faults Information 
Tag Name 

Description 

FAULTDESC String – text string describing the fault 
 

Trip Information  
Tag Name 

Description 

TOTALIDLEHRS Number – total accumulated hours in idle 
TOTALIDLEFUELUSED Number – total accumulated gallons of fuel consumed 

while in idle 

TOTALVEHDIST Number – total accumulated miles for the vehicle 
TOTALPTOHRS Number – total accumulated hours in PTO 
TOTALFUELUSED Number – total accumulated gallons of fuel consumed 
MAXROADSPEEDLIMIT Number – maximum road speed limit in miles per 

hour 
CRUISECONTROLSETSPEE
D 

Number – set speed of cruise control system in miles 
per hour 

System Specifications 

Physical 
Length: 7.71 in. (196 mm) 
Width: 3.64 in. (92 mm) 
Thickness: 1.29 in. (33 mm) 
Weight: 16 oz.  

Environmental 
Operating Temperature: -10° to 50° C  (14° to 122° F) 
Non-Operating Storage 
Temperature: 

-30° to +70° C (-22° to 158° F)  

Relative Humidity: 5% to 95% non-condensing 

Note:  Operating temperature range is limited by critical components, such 
as the Lithium Ion Battery (-10° to 50° C) and the LCD Module    (-10° to 
50° C). 

Hardware 
Processor: Samsung ARM, S3C2410, 203 MHz 
RAM: 64 MB SDRAM 
Flash: 32 MB NAND Flash 
Display: 3.8”, STN, 240x320 QVGA pixels, LED backlight 
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Battery  
The QC5100 Handheld Computer uses a specially designed Lithium-
Ion battery pack. Proper care and usage of the battery pack will allow 
it to hold a charge longer and lengthen its overall life.  The battery 
life varies in each pack according to storage, operating conditions 
and environment. 

The battery life is limited and its capacity drops little by little with 
use and with time.  If the remaining battery time is considerably 
shortened, the probable cause is that the battery pack is reaching the 
end of its life.    

 

Troubleshooting and Technical Support 
Always check all wiring to the QC5100 Handheld Computer if you 
are having problems.  Do not open the QC5100 Handheld; doing so 
will void any warranty you may have. The QC5100 Handheld has no 
user-serviceable parts. 

If you believe the unit is properly wired and is still not functioning, 
please call Technical Support. They may be reached at: 

• 1-800-433-9341 in The USA 
• 0800-286646 in the United Kingdom 
• +1-812-3778136 for international calls 

To make your call go as smoothly as possible, please have the 
following information handy when you call: 

• Make and model of the vehicle for which the QC5100 is used 
• Engine Type (for example, 98 Cummins N14) 
• Software Version of your QC5100 
• Transmission Type 
• Any electronic systems on the vehicle (for example ABS) 
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Warranty 

Products Warranted 
This warranty applies to New QC5100 Handheld Computers, sold by 
Cummins Inc. (hereinafter ‘Cummins’) and delivered to the first user 
on or after January 1, 2007. 

Warranty 
Cummins Inc. warrants to the original purchaser (“Customer”) that 
this product (Hardware) will be free from defects in workmanship 
and materials, under normal use, for ninety (90) days from the date 
of original purchase from Cummins Inc. or its authorized retailer.  If 
this product does not operate as warranted above during the 
applicable warranty period, Cummins Inc. may, at its option and 
expense, replace the defective product or part, or, if neither 
replacement nor repair is reasonably available, refund the customer 
the purchase price of the defective product or part.  Proof of date of 
original purchase will be required.  Replacement products or parts 
may be new or reconditioned.  Cummins Inc. will warrant replaced 
or repaired products or parts and hardware upgrades to which 
Customer is entitled by agreement between Customer and Cummins 
Inc. for a period of thirty (30) days from shipment of such product, 
part, or upgrade or through the end of the original warranty, 
whichever is longer.  All products or parts that are replaced become 
the property of Cummins Inc.  Cummins Inc. shall not be liable 
under this warranty if its testing and examination disclose that the 
alleged defect in the product does not exist or was caused by 
Customer’s or any third person’s misuse, neglect, improper 
installation or testing, unauthorized attempts to repair or modify, or 
any other cause beyond the range of the intended use. 

This warranty is made to the first Owner in the chain of 
distribution, and Coverage continues until the end of the period 
of coverage.  
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Return Policy 
All returned merchandise must be in saleable condition with 
manufacture’s original packaging.  Cummins Inc. and its authorized 
retailer will accept returns within (30) days of your original receipt.  
Proof of date of original purchase will be required.  All returns must be 
submitted to the point of purchase.  No refund will be granted on items 
that have been installed, used, modified or that are not in saleable 
condition in their original packaging. 
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Appendix A:  Maintaining Your QC5100 Handheld  

Datalink Cable Storage 
The datalink end of the cable should be disconnected from the 
vehicle datalink when the adapter is not in use. 

Care 
Treat the datalink adapter with care, just as you would do with any 
other handheld organizer.  Even though the QuickCheck 5100 is a 
rugged device (subject to temperature extremes and moisture) the 
screen is still susceptible to damage if not properly cared for. 
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Appendix B:  Frequently Asked Questions 
Before contacting your local Cummins distributor for support, please 
experiment a bit to reproduce and isolate the problem.  If you find it 
necessary to contact your distributor, please be ready to provide the 
following information: 

• The version of the Windows operating system you are using on 
your PC 

• The actual error message or state that you are experiencing 
• The steps you take to reproduce the problem 
• The version of QUICKCHECK 5100 software you are using and 

available memory 
• The version of QUICKCHECK CE software you are using 
• The version of POWERSPEC CE software you are using 

To find Windows operating system version information: 
• Click the Start menu in the Windows system tray on the bottom 

left side of your computer screen in the Taskbar 
• Choose Settings, then click Control Panel 
• Double-Click System 

To find organizer version and memory information: 
• Tap the application icon on the handheld organizer 
• Tap the menu button located on the handheld organizer 
• Tap Info 
• Tap Version to see version numbers, and tap Size to see the 

amount of free memory, in kilobytes 

To find POWERSPEC CE version information: 
• Tap the POWERSPEC CE  application icon 
• Tap the menu button located on the handheld computer 
• Tap Help 
• Tap About  

To find QUICKCHECK CE version information: 
• Tap the QUICKCHECK CE application icon 
• Tap the menu button located on the handheld computer 
• Tap the Options menu item 
• Tap About  
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To find ActiveSync Manager Version information: 
• Click the ActiveSync Manager icon in the Windows 

system tray on the bottom right side of your computer 
screen in the Taskbar 

• Click Open Microsoft Active Sync 
• Click  Help then About 

ActiveSync Problems 
I tried to do a local ActiveSync 
operation, but it did not 
complete successfully. 

• Verify that the ActiveSync Manager is 
running. If the ActiveSync Manager is 
running, exit and restart it. 

• Click the ActiveSync Manager and 
choose Connection Settings.  Check that 
the Allow USB setting with this 
computer is selected. Your organizer 
cannot share this connection with other 
devices, such as INSITE. 

• Make sure the USB cable is connected 
securely. 

• Verify the QC5100 is powered on.  
• Review the QC5100 Handbook, 

including its Frequently Asked 
Questions.  

I did an ActiveSync operation, 
but the Cummins QC5100 
Application Suite did not 
synchronize. 
 
 

• Verify that the QC5100 Handheld 
Computer is turned on and the USB 
connections are secure on the device and 
the PC. 

• Verify that the ActiveSync Manager is 
running. If the ActiveSync Manager is 
running, exit and restart it. 

• Turn the QC5100 Handheld Computer 
off and back on.  

• Open the ActiveSync application and 
Select Tools, then Add/Remove 
Programs. Ensure that the Cummins Inc. 
QC5100 Handheld Computer is shown in 
the list box and the Install program into 
the default installation folder option is 
checked. 
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I did an ActiveSync operation, 
but my PowerSpec CE data did 
not get uploaded to my 
computer.  
 
 

• Verify that the ActiveSync is version 4.5 
•  or later and is running.  Update it to the 

latest version without cost at the 
Microsoft web site: 
http://www.microsoft.com. 

• Manually start the Launch 
SyncReports.exe program from the 
Programs, Cummins, Cummins QC5100 
Application Group. 

POWERSPEC CE Installation Problems 
I’m having problems installing 
my Desktop organizer 
software. 

• Review the ActiveSync Problems section, 
including its Frequently Asked Questions.   

I tried to install the QC5100 
Application Suite software on 
my computer and it would not 
install. 
 
 
 
 
 

• Verify that your computer and operating 
system meet the PC requirements 
identified earlier in this document.  The 
Cummins QC5100 Application Suite 
software is not Mac-compatible. 

• Microsoft ActiveSync and the QC5100 
software must be installed on your 
computer before PowerSpec CE software 
can be installed.  If they are not installed 
on your computer, then insert the CD-
ROM into your computer and wait for the 
Installer Menu Screen.  Click INSTALL 
and follow the instructions onscreen. 

I am using Desktop organizer 
software other than the 
Microsoft ActiveSync 
software and my Cummins 
QC5100 Application Suite 
software would not install. 

• Activate the Microsoft ActiveSync 
software, install the Cummins QC5100 
Application Suite software, then activate 
the Desktop software that you use.  The 
latest version of the Microsoft 
ActiveSync software can be downloaded 
without cost at the Microsoft web site: 
http://www.microsoft.com  

• Uninstall older versions of Cummins 
QC5100 Application Suite from the 
Control Panel, Add/Remove Programs 
option of the desktop PC. Then 
reinstall the Cummins QC5100 
Application Suite.  
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I tried to install a new version 
of PowerSpec CE   software 
and it would not install 
properly on my device. 

• Uninstall the older version of software 
from the QC5100 Handheld Computer 
using the Settings, Control Panel, then 
select Remove Programs, and remove the 
Cummins Inc QC5100. Then ActiveSync 
the device with the desktop PC.  

• Uninstall the older version of software 
from the desktop PC. Select Control 
Panel, click Add/Remove Programs, then 
uninstall the Cummins QC5100 
Application Suite. 

POWERSPEC CE Hardware Problems 
My QC5100 Handheld 
Computer won’t turn on. 

• Verify the adapter cables are securely 
connected. 

• Check for bent pins on the QC5100 
Handheld connector of the adapter. 

I cannot read 
engine/vehicle data. 

• Take the datalink cable off and install 
again.  Verify that the vehicle key is in 
the ON position and the ECM is getting 
power. 

• Verify that all extension cables are 
properly installed and firmly connected. 

• Check for loose, bent, broken, or 
incorrectly installed connector pins on the 
cables. 

• Adjust the contrast 

POWERSPEC CE Application Problems 
I tried to save engine/vehicle 
data and it would not save. 

• Make sure the passwords are correctly 
entered. 

• Verify that the trip distance is at least 
one mile or more. 

I went into Browse Engine 
Reports to review my saved 
data and the application is 
slow. 

• The more records of saved data that are 
on the organizer, the longer it will take to 
view the saved data.  Removing records 
from the organizer by an ActiveSync or 
by deleting unwanted records will speed 
up the application. 
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QUICKCHECK CE Installation Problems 
I’m having problems installing 
my Desktop organizer 
software. 

• Review the ActiveSync Problems 
section, including its Frequently Asked 
Questions.   

I tried to install the QC5100 
Application Suite software on 
my computer and it would not 
install. 
 
 
 
 
 

• Verify that your computer and operating 
system meet the PC  requirements 
identified earlier in this document.  The 
Cummins QC5100 Application Suite 
software is not Mac-compatible. 

• Microsoft ActiveSync and the QC5100 
software must be installed on your 
computer before PowerSpec CE 
software can be installed.  If they are not 
installed on your computer, then insert 
the CD-ROM into your computer and 
wait for the Installer Menu Screen.  
Click INSTALL and follow the 
instructions onscreen. 

I am using Desktop organizer 
software other than the 
Microsoft ActiveSync 
software and my Cummins 
QC5100 Application Suite 
software would not install. 

• Activate the Microsoft ActiveSync 
software, install the Cummins QC5100 
Application Suite software, then activate 
the Desktop software that you use. The 
latest version of the Microsoft 
ActiveSync software can be downloaded 
without cost at the Microsoft web site: 
http://www.microsoft.com  

• Uninstall older versions of Cummins 
QC5100 Application Suite from the 
Control Panel, Add/Remove Programs 
option of the desktop PC. Then 
reinstall the Cummins QC5100 
Application Suite.  

I tried to install a new version 
of PowerSpec CE software 
and it would not install 
properly on my device. 

• Uninstall the older version of software 
from the QC5100 Handheld Computer 
using the Settings, Control Panel, then 
select Remove Programs, and remove 
the Cummins Inc QC5100. Then 
ActiveSync the device with the desktop 
PC.  

• Uninstall the older version of software 
from the desktop PC. Select Control 
Panel, click Add/Remove Programs, 
then uninstall Cummins QC5100 
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Application Suite. 

I’m having problems installing 
Microsoft ActiveSync 
software. 

• Use Microsoft Technical Support if 
needed. 

I tried to install the 
QUICKCHECK CE software on 
my computer and it would not 
install. 

• Verify that your computer and operating 
system meet the PC requirements 
identified earlier in this document. 

I tried to install a new version 
of QUICKCHECK CE software 
and it would not install 
properly on my organizer. 

• Delete the old version of software from 
the QC5100 device, then install the new 
version of software. 

QUICKCHECK CE Hardware Problems 
QUICKCHECK CE shows a No 
Adapter status. 
 
 

• Verify the QC5100 adapter cables are 
securely connected. 

• Check for bent pins on the interface 
connector of the QC5100 device. 

I cannot read engine/vehicle 
data (QUICKCHECK CE shows a 
Datalink Down! Status). 

• Take the datalink cable off and install 
again.  Verify that the vehicle key is in the 
ON position and the ECM is getting power. 

• Verify that all extension cables are properly 
installed and firmly connected. 

• Check for loose, bent, broken, or 
incorrectly installed connector pins on the 
cables. 

QUICKCHECK CE Application Problems 
I tried to save engine/vehicle 
data and it would not save. 

• Make sure an Equipment ID is entered. 
• Verify that the make, model, and serial 

number have been received.  Data from 
equipment cannot be saved without an 
Electronic Dataplate that includes the 
make, model, and serial number. 

I went into Review mode to 
review my saved data and the 
application is slow. 

• The more records of saved data that are 
on the device, the longer it will take to 
view the saved data.  Removing records 
from the device by an ActiveSync or by 
deleting unwanted records or equipment 
will speed up the application. 

Data from deleted equipment is 
showing up in other equipment 
data. 

• Always ActiveSync all data to the PC 
before a delete equipment operation is 
performed. 
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I cannot see the complete VIN, 
Software ID, or Engine Serial 
Number. 

• Tap on the VIN, Software ID, or Serial 
No data and a zoom box with the 
complete number should pop up. 

If you encounter a problem with your QC5100 Handheld Computer, 
please contact your local Cummins distributor only after you have 
reviewed the previous list of Frequently Asked Questions, the updated 
Frequently Asked Questions in the QC5100 User’s Manual.  Information 
about your local Cummins distributor can be found at our web site: 
http://www.cummins.com. 



 

 79 

Appendix C:  Fault Codes  
This section provides information about the engine and vehicle 
subsystem fault codes that you may receive from your vehicle.  PID is 
the parameter identifier.  SPN is the suspect parameter number.  SID is 
the subsystem identifier.  FMI is the failure mode identifier.  Each PID, 
SPN, SID, and FMI is identified by a number. You may notice some 
numbers missing from the following tables, as NOT all numbers have 
been defined. 

PID Number Range Supported 
1 - 511* 

* - Not all PID numbers are assigned by SAE.  If a fault is 
read by QUICKCHECK CE with a PID number that is 
unassigned, it will have a description indicating either 
“Reserved - to be assigned” or “Description Not 
Available.” 

SPN Number Range Supported 
1 - 1709* 

* - To minimize the size of the QUICKCHECK CE databases, 
not all SPN descriptions are supported.  If a fault is read by 
QUICKCHECK CE with an SPN number that is unassigned 
by SAE or unsupported in the database, it will have a 
description indicating either “Reserved - to be assigned” or 
“Description Not Available.” 

SID Number Range Supported 
1 - 255* 

* - Not all SID numbers are assigned by SAE.  If a fault is 
read by QUICKCHECK CE with an SID number that is 
unassigned, it will have a description indicating either 
“Reserved - to be assigned” or “Description Not 
Available.” 
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SAE J1587* and J1939 Failure Mode Identifiers (FMI)** 
FMI  Description 
0  Data valid but above normal operational range 
1 Data valid but below normal operational range 
2 Data erratic, intermittent or incorrect 
3 Voltage above normal or shorted high 
4 Voltage below normal or shorted low 
5 Current below normal or open circuit 
6 Current above normal or grounded circuit 
7 Mechanical system NOT responding properly 
8  Abnormal frequency, pulse width or period 
9 Abnormal update rate 
10 Abnormal rate of change 
11 Failure mode NOT identifiable 
12 Bad intelligent device or component 
13 Out of calibration  
14 Special instructions  
15 Data valid but above normal operational range (least severe) 
16 Data valid but above normal operational range (moderately severe) 
17 Data valid but below normal operational range (least severe) 
18 Data valid but below normal operational range (moderately severe) 
19 Received network data in error 
20 Reserved for future assignment 
21 Reserved for future assignment 
22 Reserved for future assignment 
23 Reserved for future assignment 
24 Reserved for future assignment 
25 Reserved for future assignment 
26 Reserved for future assignment 
27 Reserved for future assignment 
28 Reserved for future assignment 
29 Reserved for future assignment 
30 Reserved for future assignment 
31 Not available or condition exists 

* - J1587 FMI numbers run from only 0 to 15. 
** - FMI descriptions always follow the PID, SPN, or SID descriptions 
in the detailed Fault Description zoom box. 



 

 81 

Appendix D:  Glossary 
Accel Ped Pos the ratio of the current accelerator pedal position to the 

maximum  
position (in percentage) 

ActiveSync 
Manager  

Microsoft synchronization technology software 

Boost Pressure the gage pressure of air discharged from the turbocharger 
 (in pounds per square inch or kiloPascals) 

CAN 2.0B the Bosch-defined Controller Area Network message format 
and hardware interface standard that J1939 is based on 

Communicating QuickCheck CE or PowerSpec CE is in the process of re-
establishing communications on the datalink after saving 
data 

Cruise Set Spd the velocity control system setting (in miles per hour or 
kilometers per hour) 

Datalink Down! QuickCheck CE or PowerSpec CE is not reading any data 
from the datalink 

Disconnected parameter data is not being read from the datalink 
ECM Electronic Control Module 
Eng Cool Temp the temperature of coolant in the engine cooling system (in 

degrees Fahrenheit or degrees Celsius) 
Eng Oil Pres gage pressure of oil in the engine lubricating system (in 

pounds per square inch or kiloPascals) 
Engine Speed the rotational velocity of the crankshaft (in revolutions per 

minute) 
Equipment ID field containing the user's name of each vehicle entered into 

the handheld organizer 
Failure Mode 
Identifier 

the SAE-defined J1939/J1587 type of failure detected 

Fuel Rate the amount of fuel the engine consumes per unit of time (in 
gallons per hour or liters per hour) 

Handheld 
device/handheld 

Synonymous terms for the QUICKCHECK 5100 

Initial the parameter data has not yet been received 
INLINE™ another Cummins Inc. datalink adapter 
INSITE™ another Cummins Inc. service tool 
Intake Manifold the temperature of pre-combustion air supplied to the intake 

manifold (in degrees Fahrenheit or degrees Celsius) 
J1587 a low-speed SAE-defined message format used on a J1708 

interface 
J1708 the SAE-defined hardware interface for J1587 (and J1922) 

messages 
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J1939 a high-speed, SAE-defined, CAN 2.0B based messaging 
format 

Make the manufacturer of the engine or vehicle subsystem 
Max Road Spd the maximum vehicle velocity limit (in miles per hour or 

kilometers per hour) 
Model the model of the engine or vehicle subsystem 
No Adapter QuickCheck 4 is not communicating with the adapter 
Output Torque the amount of torque available at the engine flywheel (in 

foot-pounds of force) 
% Engine Load the ratio of the current load of the engine to the maximum 

rated load (in percentage) 
PID Parameter Identifier, as defined in the SAE J1587 standard 
SAE Society of Automotive Engineers, the organization that 

establishes on-road and off-road motor vehicle standards 
Saving indicates that data is being stored in a new record 
Serial No the serial number of the engine or vehicle subsystem 
SID Subsystem Identifier, as defined in the SAE J1587 standard 
Software ID the software identifier of an ECM 
SPN Suspect Parameter Number, as defined in the SAE J1939 

standard 
SyncReports 
Process 

Synchronization software created by Cummins Inc. for 
transferring data from the QUICKCHECK 5100 to the PC 

Total Eng Hrs accumulated time of operation of the engine (in hours) 
Total Fuel Used accumulated amount of fuel used during vehicle operation 

 (in gallons or liters) 
Total Idle Fuel accumulated amount of fuel used during vehicle operation 

while idling 
 (in gallons or liters) 

Total Idle Hrs accumulated time of operation of the engine while idling (in 
hours) 

Total PTO Hrs accumulated time of operation of the power takeoff device 
(in hours) 

Total Veh Dist accumulated distance traveled by the vehicle during 
operation 
 (in miles or kilometers) 

Unavailable data for the parameter is not available to read 
VIN vehicle identification number assigned by the vehicle 

manufacturer 
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Appendix E:  Connector Pin-outs 

Cable 3165160 
DEUTSCH HD16 - 6 - 12S 6-position connector 
A - J1587 +   
B - J1587 -   
C - Power + 
D - NC 
E - Ground   
F – NC 

DEUTSCH  HD16 - 6 - 12S 
FROM PIN 

DB25 Female 
TO PIN 

FUNCTION 

A 3 J1587 + 
B 4 J1587 - 
C 25 Power + 
E 23 Ground 

Cable 3165159 
DEUTSCH HD16 - 9 - 1939S 9-position connector 
A - Ground   
B - Power + 
C - J1939 +  
D - J1939 -  
E - NC 
F - J1587 +  
G - J1587 -   
H - NC 
J - NC 

DEUTSCH  HD16 - 9 - 1939S 
FROM PIN 

DB25 Female 
TO PIN 

FUNCTION 

F 3 J1587 + 
G 4 J1587 - 
C 6 J1939 + 
E 7 J1939 Shield 
D 8 J1939 - 
A 23 Ground 
B 25 Power + 

 


